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Innovator 14.2 (Innovator 14.2.1.30324) 

 Version Consistency 

Please note when updating your Innovator installations:  

Identity of model server version and client version is highly recommended for safe use of Innovator. It is 
mandatory that model server and clients have identical release numbers (XX.X.X). 

The hotfix 14.2.1.30324 is not interface-compatible with older 14.2.1.XXXXX releases. The server and client 
components of this release must be used in the same version. 

Repositories updated by transformation cannot be used in older versions.  

Overview of Version Numbers (Builds) 

Product Description Version Number (Build) 

Innovator 14.2.1 Hotfix Version 14.2.1.30324 

Innovator 14.2.1 Hotfix Version 14.2.1.20217 

Innovator 14.2.1 Version 14.2.1.11130 

About the API Documentation 

The API changes are continuously documented in the online help (see "User Customizations> 
Innovator SDK Documentation Library>Change Log"). 

Model Editor 

◼ ArchiMate Export: Export Options for Selection 

The ArchiMate® export can be run in the modes "Export Extended Selection" or "Export Selection", selectable 
via "Tools>Export>ArchiMate". In addition to the previous standard behavior of the extended export, which is 
well suited for selected diagrams and includes Innovator-specific model contents, the "Export Selection" 
command restricts to the elements contained in the selection. 

◼ DDL Generation: Comments in Separate File 

In DDL configurations, the option "One separate file for comments" in the group "Files" causes comments to 
be output to a separate file "Comments.sql", which is automatically created in the directory of the output file. 

◼ Java Source Code Import Supports Javadoc 

The Java source code import can store the content of Javadoc comments in the specification text of the 
respective model element. For this purpose, the logical name of the description text must be entered in the 
"Text for Javadoc" field in the "Generator" tab in the Java source code import configuration. Javadoc is 
supported for the element types class, operation, attribute, interface, enumeration type and enumeration 
value. 

◼ New Function 

 Changed 

 Fixed 
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 Alternative Output of CreateView Statements 

In DDL configurations, the option "AS column names in SELECT statement" in the "Formatting" group causes 
the CREATE VIEW statement to be output without explicit view columns, which instead follow the SELECT 
columns as "AS view column name". 

 DB/DDL Import/Export: Directory for Sequence Controlling Files 

The directory $INODIR\java\InoIMInOut\configuration contains all sequence controlling files for DB/DDL 
import/export. These files have been added: 

• stereos.xml with the customizable stereotypes used during import 

• stereotypeoptions.xml for converting DB options to type system options in the model during import 

• positions.xml for the positioning of type system options during DDL export 

• datatypes.xml for converting JDBC data types to Innovator data types during import and comparison with 
the model and the differences DDL export in the DB Manager 

 Specification Texts: Spell Checking Slightly Delayed 

Writing text in the specification text editor happens smoothly because the built-in spell checker is slightly 
delayed. 

 BPMN Export Exports Artifact as Text Annotation 

The export to BPMN exports an artifact as text annotation. Thus, another BPMN tool can import it as text 
annotation. When importing a text annotation, an artifact or a comment is created from it, depending on the 
existing extension. 

 BPMN: Evaluation of the Content Configuration for Lanesets without Lane 

The evaluation of the content configuration also works if a process may contain a laneset as an assigned 
element, but the laneset may not contain a lane. The model server does not shut down immediately upon 
login. 

 BPMN: Owner of Data Input and Output Not Changeable 

Data associations always run between two data objects. If you create a data association between a task and a 
data object, an invisible data object is created in the task and, depending on the direction, the data object type 
is defined as data input or output. For this hidden data object, the change of owner is rejected with an error 
message. 

 Changing Element Type Maintains the Hierarchical Subordination for Organizational Units 

If the element type for an organizational unit is changed to a different stereotype, the linked hierarchical 
subordinations are accordingly reconnected and the owner relationship of the organizational units is adjusted, 
if necessary. 

 Compartments: Position Y Irrelevant for Undo 

For compartments, the Y position is ignored when undoing.  

 Consistency of Display Format Rules 

For display format rules, the same sequence number is not reported as inconsistency. 
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 DDL Generation: Combined Subselects 

If a view has the stereotype "fromCombinedSelect" and is the target of a From clause, then the appropriate 
SELECT will be generated for the From clause in the DDL. 

 Diagrams: Standard Layout According to the Sugiyama Algorithm 

In the diagram editors, the command "Design>Arrange>Standard Layout>Arrange Diagram" is executed 
correctly. 

 DMN: Multilingualism and Test Data of Decisions 

The name of the test data file of an information (InputData) is generated in the model language to avoid that a 
change of the Innovator language regenerates the test data file and duplicates the test data sets. 

 DMN: Simulation of Informations of the "date and time" Type 

Informations (Input Data) of the type "date and time" can be simulated. 

 DMN: User-defined Data Types in DMN 1.2 

When referencing user-defined data types, the namespace is exported in the correct format. 

 Drag-and-Drop from Used Event Definition to Event 

When an event definition is dragged onto an event, the event definition is assigned to that event. If the same 
event definition is again dragged onto the same event, no change is made and no message regarding double 
usage occurs. 

 ER-DB Mapping: Split of Merged Database Tables 

Merged database tables with unexpected or missing mapping dependencies to ER elements are treated as 
unmapped database tables when split up again. 

Due to missing technical information, the result of the splitting can be different from mapped tables and may 
have to be post-processed. 

 Excel Import Supports Formulas 

When importing Excel files, the values that are calculated by formulas are also imported. 

 Impact Analysis Saves Selected Configuration 

When the user selects a model-wide content or display configuration in the "Impact Analysis" context tab, this 
configuration is saved on the analysis diagram if the user has the necessary access rights. 

 Java Source Code Import Supports Associations 

The Java source code import creates an association when a class has an attribute typed with a class or with an 
interface and the type is imported at the same time as the class. Example: public class ClassA { private ClassB 
myB; }. 

For template classes or interfaces, an association is also created, but not with the template parameter, but 
with the bound template class or interface. Example: public class ClassB { private List<ClassC> myListC; } 
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A multi-valued association is created if the type is an array type. Example: public class ClassC { private ClassD[] 
myDs; }. 

Only the primitive types of the model configuration whose stereotype is configured during source code import 
are used. The classes and interfaces that are in the library are reused in the model. The stereotype of the 
library is configured during source code import. 

 Model Fragments: Importing Entities Without Their Relationships 

Importing model fragments is also successful with entities without their relationships. Referenced entities are 
imported as placeholders if necessary. 

 Placeholder Replacement in Formatted Texts 

Placeholder replacement ($(name)-expansion) in formatted texts no longer leads to inconsistency of the text 
in special cases. 

 Role Change with Diagram Opened 

Performance has been improved when changing roles while diagrams are open. 

 Search Clears Initial Cache 

The model editor works on cached server results. In order for a search to find other users' changes 
immediately, it initially clears the cache. 

 UML: Creating Port Nodes 

When creating port nodes, an error message is displayed if the selection is unfavorable, thus preventing the 
server from being inconsistent. 

 Undo Without Privilege "Configurating" 

If you change a text on a protected package via API or property editor, this change can be undone even 
without the "Configurating" privilege. 

Configuration 

◼ DDL Generation: Table Column with Direct Sequence 

Table columns can be used directly like sequences - similar to the DDL generators for sequence data types. For 
this purpose, a stereotype property of type "Enumeration" with the name "GenerationType" and the values 
"DEFAULT" and "ALWAYS" must be configured. 

 Details Configuration: Inserting Copied Documentation or Details Chapters 

When inserting copied documentation or Details chapters into the Details configuration, it is ensured that the 
copied chapters are permitted at the insertion point. Restrictions can result from the type of chapter or the 
represented element type. 
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Innovator 14.2 (Innovator 14.2.1.20217) 

General Functions 

 Change Logging: Privilege Renamed 

The privilege "Viewing Changesets" has been renamed to "Viewing Change Logs". 

 ER-DB Modeling: UUID as "Deutsch" Data Type 

The target system "Deutsch" contains a data type "UUID" (Universally Unique Identifier). 

Model Editor 

 Impact Analysis: Handling of End Elements 

When using end elements, the graph only will be shown wenn at least one end element is within the analysis 
range. If not all end elements can be reached, an information item is shown on the start element. 

Basically, the graph contains all nodes and edges on any path between the start and end element. This means, 
also cyclic paths will be shown. To prevent this, you can use the toggle command "Impact Analysis>Graph> 
Hide Cycles". 

 BPMN Import Supports Processes Without Names and More 

The import of BPMN files supports processes without names and also other problem cases. 

 If a process has no name, it will be given the name of the participant in which it is used. 

 If a name contains a Windows line break followed by a space, this will be replaced by a space. 

 If a participant node does not contain a process, it will be collapsed and displayed as a black box pool. 

 Change Logging: Element History Can Be Accessed Without Using Change Sets 

The "History" command is available for an element, even when the option "Display backstage view 'Change 
Sets'" in the dialog "Configure Change Logging" is disabled. 

 DDL Import: SELECT in From Clause 

The DDL import supports SELECT statements in the From Clause when creating a database view. In this case, a 
new database view is created with the stereotype SELECT in From clause, respectively, combinded SELECT in 
From clause, when the SELECT itself is a combined view. 

 ER-DB Modeling: From Clauses in ER Table Editor of Cubes 

In the ER table editor, you can create From clauses in cubes using the ribbon menu. 

 Excel Export Supports Equally Named Properties 

The export to Excel can export model elements that have properties of the same name. The name of the 
property is supplemented by a suffix to distinguish the columns in the Excel table. This is the name of the 
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profile in which the stereotype property, type system option, label, or text specification is defined. If this is not 
unique, the name of the property is output followed by a number. 

 Excel Import Supports Inherited Redefined Steretypes 

The Excel importer also imports the value of stereotype properties, which have been created on an inherited 
redefined stereotype. 

 Excel Import Suppresses Carriage Return 

When importing texts from Excel files, the importer suppresses the character "_x000D_", which stands for 
"carriage return" when followed by a "new line" character. Only the "new line" character will be imported. 

 Excel Import: Considering Automatic Name Maintenance 

If the import from Excel modifies the name of an element, this change is treated like a user originated change 
in the properties tool window. This means, that the new name is protected against automatic maintenance. 
For example, the name of a realized concept will not be reflected on the target concept of the realization 
anymore. If automatic name maintenance is desired, the name of the concept needs to be reset to default in 
the property tool window. To have the Excel import care for name maintenance, you need to import the 
property "Name Type" with the value "Initial" along with the concept. 

 Excel Import: Limitations on Concept Connections Eliminated 

Concept Connections can be imported: 

 when the owner has been changed and the configuration disallows more than one dependency 

 when no create template is defined but a creation is still possible using the properties tool window 

 when referenced by another Concept Connection by name, so that Concept Connections pointing to other 
Concept Connections can be used 

 Excel Import: No Delay When Opening Dialog 

The dialog "Check Data for Excel Import" will always be opened within seconds. 

 F1 Opens Default Browser App 

When opening the help menu from within the model editor or the administration program, the default 
browser app registered with windows will be used. 

 Impact Analysis Reacts to Role Changes 

The impact analysis reacts correctly to the change of the user role. 

 Impact Analysis: Hiding Relationships With a Special Stereotype 

In the impact analysis diagram, an edge can be selected in the graph and its stereotype filtered in the context 
menu. Filtering relationships by their stereotype works correctly. 

 Impact Analysis: Performance Improvement 

The speed of the analysis incorporating the content configuration has been significantly improved, especially in 
large models. 
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 Model Fragment Import: Consistency Faults Prevented 

When importing a model fragment of a profile using element identification via namespace, the enumeration 
type of a stereotype property or a label is also associated via the namespace and not via the UUID. The 
consistency message "No Default Value Has Been Found" no longer appears. 

 Specification Texts: Links to Files Can Be Copied 

Hyperlinks of the type "file" within specification texts can still be evaluated after copying to Microsoft Word. 

 Synchronizing Model Elements: Access Rights for Merging a Process Definition Diagram 

If the access rights for the executing user are not available when merging a process definition diagram, it is 
ensured that the view on the process can still be added to the diagram when merging. This prevents 
inconsistency in the model. 

 Synchronizing Model Elements: Comparison of Partial Models 

When in the comparison of partial models some elements in the right model have been referenced, which 
themselves did not reside somewhere below the comparison root, then these elemets were treated as 
placeholders and as such not incoporated in the comparison. 

Now all those elements are displayed completely with all their attributes and fully incorporated in the 
comparison. 

Configuration 

 Create Defaults Include Multiple Stereotypes for Business Objects and Linked Structures 

When dragging a structure definition on a data object within a process, a business object will be created and 
automatically linked to that data object. Using a particular configuration of create defaults, it is possible to 
support different stereotypes for all affected elements. The evaluation of this constellation has been improved 
which leads to a correct creation of business objects. 
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Innovator 14.2 (Innovator 14.2.1.11130) 

General Functions 

◼ Access to Models of Other Project License Servers 

In the administration program and in the model editor, both independent and managed models of other 
project license servers can be accessed if corresponding login rules exist for the user. The configuration editor 
cannot be opened for models from other projects. 

If multiple projects are running, the model editor shows a drop-down list of projects in the "Open & Login" 
backstage view as well as in the dialog for model selection, e.g. for model comparison. 

When logging in, the license is debited from the user client's own license server (INOHOST). 

◼ Convert Model Version to Model File 

A model version of a managed model can be converted into a local model file, e.g. to share it outside the 
network. The command is located in the model editor in the backstage view "Verify & Export" and in the 
administration program in the menu ribbon tab "Model" as well as in the context menu of a model version. For 
execution, the privilege "Export models" is required in the model editor and a model administrator rule in the 
administration program. 

◼ Documentation: Use SVG Graphics in XML/HTML Documentations 

Documentation commands can be configured to generate XML/HTML documentation with SVG graphics. 
Output of a graphic on multiple pages is not supported when this format is used. 

 Java: Runtime Environment is Part of the Installation 

Innovator is shipped and installed for Windows with its own OpenJDK runtime environment (version 11). No 
additional Java runtime environments need to be installed on the server or client to use Innovator. 

By default, this included runtime environment is used for all Java-based Innovator functions. If a different 
runtime environment is to be used, it can be configured via the inojvm.ini file. 

 Login to Models of Other Accessible License Servers 

Project license servers of version 14.2 no longer display repositories running on the main license server as 
enterprise repositories. For project license servers from previous versions, the behavior remains unchanged. 

Models of other available license servers of the same Innovator version can be edited from version 14.2 
without changing the INOHOST and without restarting the application. This replaces the concept of enterprise 
repositories. 

Access to models of other available license servers is possible in the administration program and in the model 
editor. When logging on to the model, the license is debited from the user client's own license server 
(INOHOST). 

 Migration: Guest Logins Are Prevented by Default 

During the transformation to version 14.2, guest logins in the models are prevented by default. If this behavior 
is undesired, it can be switched off by setting the environment variable "INOTRANS_DONT_BAN_GUESTS". 
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Administration 

◼ Managed Models: Change Logs Optional for Version Creation 

When you create a new version of a managed model, you can decide whether to adopt the change log of the 
source model. If, for example, a version is created to make individual changes and then merged with the 
source model again, the change logs do not necessarily have to be transferred. This can contribute to saving 
system resources. 

◼ Managed Models: Defining Resource Quotas 

The resource consumption of a managed model can be limited and displayed in terms of main memory and 
disk space. 

This allows users to use functions such as creating new model versions and launching them independently 
within these limits without compromising the system's operational security. 

In the administration program, under "View>View>Edit Properties", the maximum quota for the main memory 
and the hard disk space of all model versions can be defined. This requires the "Manage Environment" right. 
The used resources of a model version are displayed in detail under "View>View>Show Information". 

When creating or starting model versions, the set limits are checked and a corresponding error message is 
displayed to the user if they are exceeded. 

◼ Modell Server Uses Multiple Threads 

The model server uses multiple threads for some commands. This shortens the response time, e.g. when 
comparing models,  displaying diagrams or searching. 

The number of threads used is determined by the number of processor cores available, but is limited to a 
maximum of eight. 

 Environment Variables for Network Address Translation (NAT) 

To better support integration into a Network Address Translation (NAT), the environment variable 
INO_NAT_HOSTNAME replaces all previous environment variables for NAT. 

The external host name specified with the environment variable as host name must be resolvable via DNS to a 
valid IP address. 

All components use this host name for communication, regardless of the host name registered on the 
computer. 

The preset NAT host name is displayed as the host name in the administration program and in all interfaces. 

A remapping of communication ports via NAT is still not supported with Innovator. 

The following environment variables are no longer used:  

 HOSTNAME 

 INO_NET_USE_HOSTNAME 

 INOSRV_NAT_HOSTNAME 

 INOSRV_NAT_IPADR 

 AGENT_NAT_HOSTNAME (Systemumgebung) 

 AGENT_NAT_IPADR (Systemumgebung) 
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 LDAP Synchronization: Settings for Automatic Synchronization 

Settings for Automatic Synchronization can be saved independently from user specific settings. The settings for 
automatic LDAP synchronization are made in the dialog "Synchronize User Configuration with LDAP Server" in 
the separate tab "Automatic Synchronization". 

 Managing Model Versions 

In the "Managed Models" tab of the administration program, model versions that you cannot edit due to 
missing version rules are marked in italics. 

For model versions, guest logons can be allowed or denied  without having to open the configuration editor 
under "View>Edit Properties". This is done in the expander "Logins". 

 Transformation of Model Fragments not Applicable 

The functionality for transforming model fragments has been removed. 

 User Management: Filtering by "User Name in Model" for Member Assignment 

In the dialog for assigning members to a group, the filter also affects "User Name in Model". 

Model Editor  

◼ Specification Texts: Deleting Table Rows and Columns 

If multiple cells are selected in a table in a specification text, the affected rows or columns can be removed 
using the commands "Delete Rows" and "Delete Columns". 

◼ BPMN: Additional Verify Options 

The verify options VFY555 and VFY556 check the number of incoming and outgoing sequence flows  for 
gateways depending on the specified flow effect. If the number falls short of or exceeds the expected number, 
a verification message is generated. 

The verify options VFY560 and VFY561 can be used to check the sum or absence of probability values at 
sequence flows. If there are several outgoing sequence flows at a node, then all of them should have a 
probability and the sum of all single values should be 100. Gateways with the types Parallel, Inclusive or 
Complex do not evaluate the sum. 

◼ BPMN: Delete Nodes from Sequence Flows 

If you have a chain of sequence flows with several intermediate nodes in a process and delete an intermediate 
node, then the intermediate node and the outgoing sequence flow will be deleted and the incoming sequence 
flow will be connected to the subsequent node. 

If the intermediate node has several incoming sequence flows and one outgoing sequence flow, then all 
incoming sequence flows will be connected to the subsequent node and the outgoing sequence flow will be 
deleted. 

If the intermediate node has several outgoing sequence flows and one incoming sequence flow, then all 
outgoing sequence flows will be connected to the node of the incoming sequence flow and the incoming 
sequence flow will be deleted. 



ReleaseInfo Innovator 14.2 (Innovator 14.2.1.11130)  

 11  

If the intermediate node has both several incoming and several outgoing sequence flows, then no decision is 
possible. In this case, the intermediate node will be deleted along with all involved sequence flows. 

◼ BPMN: Drag-and-Drop in Definition Views Enhanced 

In BPMN diagrams, the following additional drag-and-drop options are available: 

 If a process is dragged into the definition view of a collaboration, a participant is created and the process is 
connected as process reference. 

 If a process is dragged into the definition view of a process, a call activity is created and the process is 
connected as called element. 

 If you drag an event definition to a sequence flow in the definition view of a process, the sequence flow is 
divided by a newly created event with associated event definition. 

◼ BPMN: Dragging Sequence Flow to Sequence Flow 

A new sequence flow can be dragged from the carousel onto an existing sequence flow. The existing sequence 
flow is then interrupted by a new gateway and the new sequence flow is connected to this gateway as the 
target. 

◼ BPMN: Generic Artifacts 

Any model elements can be represented in processes by generic artifacts. Association artifacts can be used to 
link the generic artifacts to any elements within a process. Like sequence flows, connections must not exceed 
process or sub-process boundaries. 

◼ BPMN: Modeling of Groups 

The artifact Group provides a visual mechanism in the BPMN diagram to identify flow nodes and data objects 
as thematically related. A group is only used to visually highlight an unmodelled context and cannot be 
connected by flows. Groups have no influence whatsoever on the process flow. 

When creating a group in the diagram, the first found definition of a process or collaboration is automatically 
used as the owner. If the group is dragged around several nodes of the owner, the corresponding flow 
elements are automatically assigned to the group the next time the diagram is updated. 

◼ Change Logging Can Be Used Without Changesets 

The changelog can also be used without changesets. This can be applied when model changes still need to be 
traceable, but users do not want use changesets for organizing their work assignments. Therefore the option 
"Show Changesets" must be deactivated in the administration dialog "Configure change logging". Then the 
changes are logged, but no changesets for the users and no "Change Logging" backstage will be displayed. 

◼ Concept Diagram (ArchiMate): Optional Relationship Wizard 

In concept diagrams, if the option "Display relationship wizard in carousel" is activated (options dialog, 
"Mouse" tab), any connection can be dragged onto a diagram node using the "magic wand" icon in the 
carousel. In a dialog, you can select a valid connection and specify whether the connection should be created 
in the reverse direction. 
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◼ DMN: Align Test Data to Model Data 

When decisions are verified, the test data stored in the assigned information is additionally compared to the 
model data regarding its structure. The necessary changes to the test data can be viewed and then confirmed 
or rejected. Values of unchanged entries are retained. 

When you select test data records for the simulation of decisions, the structure of test data and model data 
will also be compared and the simulation will not be executed if there is a deviation. 

◼ DMN: Columns for Annotations in Decision Tables 

You can create any number of columns for annotations in decision tables. These columns are arranged after 
the output columns. Any comments can then be assigned to each rule in these columns. 

◼ DMN: Export and Import of DMN 1.1 and 1.2 

DMN export can take place in DMN version 1.1 or 1.2. The DMN import also supports both versions, wich are 
automatically determined from the input file. 

◼ DMN: Fill Empty Cells of Input Columns of a Decision Table 

For a selected decision table, all cells of empty input columns can be filled with the default value '-' to mark the 
input as irrelevant for the contained rule. The command "Fill Up Empty Cells" is provided in the context menu 
of the decision table. 

◼ DMN: Lists of FEEL Primitive Types 

In DMN, lists of FEEL primitive types are available for simpler modeling. Like the basic types themselves, these 
can be selected via the type assignment dialog. 

In the profile "FEEL Types" there are structure definitions which use the existing primitive types for the 
connected classifiers. Each structure definition is named after the primitive type followed by the suffix "list" 
and has the property "is collection" activated.  

◼ DMN: Multiple Test Cases Can Be Started Simultaneously For Simulation 

In the DMN simulation of a decision, multiple test cases can be started at the same time; they are executed 
one after the other. The output contains the results of all test cases. 

◼ Impact Analysis Diagram 

Impact analysis is implemented as a new diagram type, which replaces the previous tool window. 

With the impact analysis, any interconnection of an element can be tracked, displayed in a dependency graph 
and managed in a separate diagram. 

The content and layout of the diagram is calculated dynamically. Starting from a start element, an analysis can 
be run. Certain end nodes can be specified for a path analysis. These settings, the analysis range and the graph 
orientation are stored in the Impact Analysis diagram. 

A content configuration can be used to specify for individual elements of the graph, all elements of a 
stereotype or element type or chains of them (paths) whether they should not be used at all in the graph, as 
nodes, end nodes or as edges for simplification. When used as an edge, the evaluation direction can be 
chosen. 



ReleaseInfo Innovator 14.2 (Innovator 14.2.1.11130)  

 13  

A display configuration can be used to influence the display of nodes and edges by specifying the color, line 
style, arrowhead, and properties with which they are displayed. This configuration can be saved user-
specifically and model-wide. 

◼ Keyboard Shortcuts for Change Size in Diagram 

The diagram provides keyboard shortcuts for resizing selected elements. 

 Change Size>Same Width: Ctrl+F7 

 Change Size>Same Height: Shift+F7 

 Change Size>Same Height and Width: Shift+Ctrl+F7 

◼ Model-wide Storage of Application Settings 

In several editors, settings can now be saved not only user-specifically, but also in the model. This makes them 
equally usable for all users of the model. 

Initially, settings can only be saved user-specifically. The privilege "Edit model-wide Configuration" allows 
existing user-specific settings to be saved into the model so they become model-wide application 
configurations that can be used by all users. 

The settings of the "Beamer" tool window previously saved in the profile are being automatically converted 
during the transformation. 

This principle works in the following editors and procedures: 

 Impact Analysis 

 Beamer (user-specific settings are limited to one model) 

 Table for content 

 Synchronize model elements 

 Search 

 Perspectives 

◼ Search: Advanced Search in Models 

The "Advanced" tab of the "Search" dialog offers new options for searching model contents to advanced users. 
A query language based on SQL can be used to formulate complex and composite search expressions. An 
editor with intelligent syntax completion supports the user with this task. Predefined searches then also can be 
provided directly in the model and used by other users. 

◼ Synchronize Model Elements: Export Comparison Result to Excel 

With the command "Synchronize>Export>Excel" all displayed properties of the comparison result are exported 
to an Excel file (xlsx) for protocolling. 

◼ Synchronize Model Elements: Using Saved Searches in the Right Model 

When comparing and merging model elements, you can use saved searches in the right model. The oldest 
creation time of the model elements found as a result can be selected as the reference time for comparison in 
Merge mode. 
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 Attachments: Size Limits for upload 

The size of file attachments is limited to a maximum of 256 MB to avoid problems caused by oversized 
attachments. 

 BPMN Export: Performance Improvements 

The execution times of the export to the BPMN format has been improved. 

 BPMN: Default Sequence Flow Without Condition 

If the property "is default" is activated for a sequence flow, this property must not have a condition according 
to the BPMN specification. Consequently, the properties for local and global conditions and for the use of 
decisions and their values in the list of properties of a default sequence flow are omitted. Any existing values 
of these properties are automatically deleted when "is default" is activated. 

If an existing default sequence flow previously had a condition, this is not displayed in the diagram. The 
property in question is displayed in the property editor exclusively for deletion. 

 BPMN: Drop-Down List for DMN Condition at Sequence Flows Extended 

The drop-down list of the condition at a sequence flow depends on the decision used and all DMN decisions 
and business logic that can be reached via it. All decision tables, lists, and relations defined within these 
elements can provide values for the drop-down list. For the decision table, these are the output values and for 
lists and relations, the rows. In the case of relations, the values of the columns are separated by commas and 
combined to form a single value. 

 BPMN: Process Call Changeable without Access Right to the Called Element 

The exchanging of the called element of a call activity is not rejected even if the access right is missing. 

If you exchange the called element for a call activity, the connected data objects are added to the called 
element if necessary. The prerequisite for this adjustment is that this is the first call of the element and that 
access rights to this called element exist. Otherwise, the adjustment is not made. 

 BPMN: Rename Condition at Sequence Flow in Diagram 

If the local condition is part of the display name in the display options of a BPMN diagram for the sequence 
flow edge, then it can be renamed using F2 when the edge is selected. This also works if the condition was 
previously empty and therefore not visible. 

 Concept Diagram (ArchiMate): Improved Usability 

Multiple nodes can be dragged onto another node. The target node is then displayed as container and the 
elements are placed there. 

A layout can be saved for each edge. The user can select one or more edges and assign them to one of the 
following layouts using the mini toolbar in the context menu: 

 Direct connection 

 Rectangular connection 

 Polyline 
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 DMN: Simulation Uses Drools 7.29 

The DMN simulation uses Drools (www.drools.org) in version 7.29.0.Final from 05.11.2019. 

 ER-DB Mapping Does Not Change Automatically Mapped Database Tables 

The default ER-DB mapping does not change database tables created by the automatic mapping. This affects 
as well the properties of the database table as the contained table columns, unique key, and foreign key. 

 ER-DB Mapping Easily Customizable 

In the "Editor Mapping" tool window, the "Configuration" command can be used for individually customizing 
the M2M-SDK-based mapping between database schema and conceptual model, between multidimensional 
model and database schema, and between conceptual and object-oriented model with regard to flow control 
and model transformation. 

 ER-DB Mapping Uses Standard Mapping Dependency 

When mapping between the entity relationship model and the database model, the default stereotype of 
mapping dependency is used for all databases. 

 ER-DB Mapping: Short Name Constraints Not Applied To Empty Names 

Name constraints for short names apply only to assigned names. Multiple elements with empty short names 
are permitted. 

 ER-DB: Denormalization of Sibling Tables 

When merging tables using foreign keys that are linked with "Constraint (of disjoint DB Tables)", this link is 
transferred to the target table without checking the configuration. 

 Excel Export and Import: Profile Name in Square Brackets 

When exporting and importing Excel files, the profile name of the stereotype or creation template is enclosed 
in square brackets []. 

 Find: Standard Search with Stereotype Possible 

In the "Find" dialog, you can also select a stereotype as an alternative to an element type. This makes it easier 
for users to create search queries with model elements they are familar with. 

 Model Logon: Simplified Model Selection 

On the backstage "Open & Login" in the section "Model Servers in the Network" as well as in the login dialog 
used by Model Comparison and Office Integration, only those models are presented to the user in which a 
login is actually possible based on the rules in the central user management. 

 Name of Create Defaults 

When you create a create default, the redirected stereotype is used as its name basis. If necessary, this name 
is made unique within the namespace. If the redirected stereotype is changed, the name of the create default 
is adjusted. 

A manually changed name of a create default can be reset to the default name. 
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 Synchronize Model Elements: Automatically Determined Reference Times Extended 

When merging models, certain reference times are automatically determined. The version creation time of the 
left model is also offered as the reference time if it is a managed model version. If both the left model and the 
right model are managed model versions, both creation times are offered for selection and the younger time is 
automatically preselected . 

 Whiteboard Diagram: Edges for Activity Resources and Business Objects 

In the Whiteboard diagram, the activity resource diagram edge can only be added, not created. The diagram 
edge for business objects is replaced by the reference edge for the property "Structure Definition". 

During migration, the corresponding menu commands for creating diagram edges are removed. 

 BPMN: Order of Lanes 

The order of lanes always results from the representation in the definition diagram of the process. When 
creating a new lane, the order is adjusted beforehand if necessary. 

 Change Logging when Copying Diagrams 

For annotations in diagrams, the associated graphical elements are logged using the associated logical 
information. When the diagram is copied, the logical information may not be available for the change log of 
the affected elements. In this case, the change logging for the affected elements does not take place and thus 
does not lead to the shutdown of the model server. 

 Excel Import of Multi-Line Element Names 

Innovator does not support multiline element names, so line breaks are removed when importing element 
names. 

 Excel Import: Enumerated Values Correctly Imported 

The Excel import imports an enumerated value with the properties "Text of Specification Expression" and 
"Enumeration Value". 

 Import of a Model Fragment with Model Root 

When importing a model fragment that includes the root node of the Innovator model, all existing application 
configurations and database connections in the target model are retained. Any display languages defined in 
the target model that are neither contained in the model fragment nor used by a translation value in the 
target model will be deleted. 

 Specification Texts: Copying Texts from Microsoft OneNote 

Texts from Microsoft OneNote that contain hard line breaks can be copied to specification texts, saved there 
and opened again. 

 Specification Texts: Preserving Hyperlinks when Copying 

If a hyperlink containing umlauts is copied in a specification text and inserted in Word, the link remains 
functional. 
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 Stereotype Display in Table Editor for Content 

Stereotypes without localized names are displayed in the table editor for content as a combination of logical 
stereotype name and localized generalization name. 

Configuration 

◼ BPMN: Assignment of Event Definitions to Events 

The property "Event Definition" of the element type "Event (BPMN)" can be configured. This allows restricting 
the list of approved event definitions. 

The model templates contain the configuration already  so that the events and event definitions can be used 
without problems. 

The configuration is also included in the migration profiles. During the transformation, the "Event Definition" 
property is configured in the profiles in which the owner of the event or event definition has been defined. 

◼ Documentation: URI for Diagrams 

The property "URI" is supplied and evaluated for diagrams like for model elements. 

◼ Privilege "Edit model-wide Configuration" 

The "Edit model-wide Configuration" privilege is required to save and edit user-specific GUI settings in the 
model as model-wide application configurations. Model-wide configurations can be used by all users. 

The privilege  applies to the following editors and procedures: 

 Impact Analysis 

 Beamer 

 Table for content 

 Synchronize model elements 

 Search 

 Perspectives 

◼ Structure Definitions in Profiles 

Structure definitions can be created in profiles. 

To do this, select the stereotype for the structure definition in the "Stereotype" view and choose 
"Create>Structure Definition". In this structure definition, another structure definition or a primitive type from 
the current or an imported profile can be specified for the feature "Connected Classifier". 

This allows e.g. lists of FEEL types to be provided for decisions. 

 Documentation Command: Java Command Property Removed 

For documentation commands, the "Java command" property, never evaluated for Innovator X Generation, 
together with the classpath and virtual machine arguments, is no longer applicable. This property is removed 
during the transformation. (Innovator uses the property "Postprocessing Command".) 
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 Documentation: Additional Details for Operations 

For operations the properties "Realizes" and "is Realized by" are available for the details tree and 
documentation. 
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